
September 2009 Master Load and Update 
 
 
The September 2009 Master Load is the newest version of the AristoCAT 
software. 
 
This document describes the enhancements and changes in the September 
2009 Master Load and Update.  Note that you must install the September 2009 
Master Load, before you can install an update.  You do not need an install code 
to install this update, but you do need an install code to install the September 
2009 master load.  We will be uploading to the web site updated versions of this 
September 2009 Update on a regular basis and we strongly encourage you to 
download each new version as they become available. 
 
For any questions regarding this update, please contact AristoCAT support at 
support@aristocat.com or 800-727-4786. 
 
 

Change History 
 
The following is a list of changes incorporated in this update.  The changes are 
listed in reverse chronological order, so that the most recent changes are listed 
first. 
 
 
July 19, 2010 

1. File Management program – In the June 28, 2010 update description 
(below) a change was made to the Archive Options to allow you to select 
what file types you want to archive.  The same change has been made to 
the Copy, E-Mail and Zip menus.  Why this change?  If you regularly copy 
files from one computer to another or e-mail files to a scopist, you can 
quickly select what file types you want to copy or e-mail and with one click 
copy all of those file types.  Click the Help button for details. 

2. Real-time program – you can now set the background and text colors of 
the real-time screen.  To set the colors of the real-time screen, start the 
real-time program, when asked for the name of the note file, click the 
Cancel button.  Then click the Edit menu and then click either the “Font 
and Color Setup” menu or the “Large Text Font and Color Setup” menu. 

3. ACAT Menu – Under the Web Site menu, there are two new sub-menus, 
“Install Update” and “Update Details”.  If you click the “Install Update” sub-
menu it will start the install process for the most current update (currently 
the September 2009 Update).  If you click the “Install Details” sub-menu it 
will open the install details PDF file (this file) so that you can see what 
changes have been made to the most current update (currently the 
September 2009 Update).   

 
 



June 28, 2010 
Two enhancements have been made to the file management program. 

• Under the Archive menu, on the Archive Options sub-menu, you can 
choose which file types you want to archive.  For example, you can elect 
to archive the .WRK, .NOT, .WAV, etc.  Note that this option is only 
applicable when under ‘View Files of Type’, you have chosen ‘Job Files 
(job.*)’.  Click the Help button for detailed information about using this 
option. 

• A new sort order (Sort By) has been added.  The new sort order is ‘Date – 
Custom’.  This option allows you to sort your files by year or month and 
year.  Why might this option be useful?  Say you want to back up your 
2008 files and erase them from your hard drive.  The following steps 
would be used: 
1. Under Sort By, click on Date – Custom.  Now click on By Year and 

type 2008 in the year field. 
2. Under Removable Media Drives, browse to where you want to copy 

your 2008 files. 
3. Click the Select All button so that all of the 2008 files on your hard 

drive are selected. 
4. Now click on the Copy menu, then the Copy to Removable Media sub-

menu.  All of your 2008 files will be copied to the removable media. 
5. It is recommended that at this time you click the Backup menu, then 

click the Backup User Files sub-menu.  This will put a copy of all of 
your user files, in zip format, along with your 2008 files (you can’t have 
enough copies of your user files). 

6. Now stick in another removable media and repeat steps 2 through 5.  
This will give you a second copy of your 2008 files. 

7. Oh what the heck.  Let’s stick in another removable media and repeat 
steps 2 through 5.  This will give you a third copy of your 2008 files.  
Why not?  It is quick and easy and removable media is cheap. 

8. Be sure to keep one copy of your 2008 files off-premise in the event of 
theft or fire. 

9. Now that you have three copies of your 2008 files, click the Select All 
button to highlight all of your 2008 files on the hard drive, then click the 
Erase menu, then the Erase from Hard Drive sub-menu.  Remember 
that all files erased from the hard drive in the file management program 
are put in the Recycle Bin.  So if you make a mistake, you can restore 
one or more of the deleted files.  Eventually, you will want to empty the 
Recycle Bin. 

 
Hint:  You may want to make one of the back up locations a folder on your 
hard drive.  This will make it easy and convenient to restore a file from 
2008 if needed.  For example, if your reporter code is Chris and all of your 
files are stored in C:\Chris, then you could make a folder named 
Chris2008 on your C: drive and store a copy of the 2008 files there.  
Important:  Do not make C:\Chris2008 the only back up location of your 



2008 files.  If your hard drive crashes, then you will lose both C:\Chris and 
C:\Chris2008. 

 
 
June 1, 2010 
Four additional auto-fill features have been added.  In case you do not know 
what auto-fill is, you can have certain information automatically filled in when you 
insert an include file during translation, real-time and edit.  This information 
includes dates, times, attorney names, etc.  To get more information about using 
auto-fill, go to the AristoCAT Resources icon, click on the Tutorials toolbar and 
then open the IncludeFiles.pdf file.  The new auto-fill variables are: 

1. [>Witness] – you can now type in the witness name and when you bring in 
an include file, such as the sworn statement, you can have the witness 
name filled in.  You can fill in the witness name on the translation and real-
time options dialog box and where ever you fill in the attorney names.  
During a real-time session, you can press the F2 function key and change 
the witness name, so that if you have several witnesses during the real-
time session, you can change the witness name on the fly.  In Edit, click 
on the View menu, then click the View Speakers to change the witness 
name. 

The following auto-fill variables are filled in by the Print, Multipag and ASCII 
programs when you print or make an ASCII file: 
2. [>fp] – this auto-fill variable is filled out with the first page number of the 

transcript. 
3. [>lp] - this auto-fill variable is filled out with the last page number of the 

transcript. 
4. [>tp] - this auto-fill variable is filled out with the total number of pages in 

the transcript. 
 
An example of how these may be used in a certificate page: 
 

I do hereby certify that the witness [>witness], appeared before me and 
the attached [>tp] pages, numbered [>fp] through [>lp] is a complete and 
accurate transcript of my stenographic notes. 

 
Notes: 
On most transcript formats, the transcript numbering begins with the first 
physical page and continues through the last physical page and the total 
pages is calculated by subtracting the first page number from the last page 
number and adding one.  For example, if the transcript begins on page 1 and 
ends on page 100, then the total pages are 100 - 1 + 1 = 100 pages.  Or if the 
second volume of a transcript begins on page 135 and ends on page 262 
then the total pages are 262 – 135 + 1 = 128 pages. 
1. If your transcript format calls for the first page number to begin with the 

first page of testimony (that is, you don’t count the title, appearance or 



exhibit pages) then you can use the .fp dot command at the beginning of 
the testimony page to indicate that the first page should start here. 

2. If you have pages at the end of the transcript, such as a signature page or 
a billing page, that you don’t want counted, then use the .lp dot command 
on the last page of the transcript you want to count.  For example, if you 
have at the end of your transcript a certificate page, a signature page and 
a billing page and you don’t want to count the signature and billing pages 
as part of the total pages, then put a .lp dot command anywhere on the 
certificate page. 

3. If you have a .pn dot command in the middle of a transcript to restart the 
page numbering, then the total pages [>tp] calculated will probably not be 
correct.   

4. You can use the total pages [>tp] auto-fill variable without having to use 
the first page [>fp] and last page [>lp] auto-fill variables.  For example: 

 
I do hereby certify that the witness [>witness], appeared before me and 
the attached [>tp] pages, is a complete and accurate transcript of my 
stenographic notes. 

 
 
May 20, 2010 
Two enhancements have been made to the Edit program.  Both enhancements 
require that the auto spell option be turned on.  To turn on auto spell, click on the 
Edit preferences toolbar (or click the Edit menu, then click Preferences), then 
check the box “Start Auto Spell”.  The enhancements are: 

1. You can right-click on a word to get options for that word.  One option is 
Definition.  If you want to see the definition for that word, left-click once on 
Definition to see the definition.  When you are finished with the definition, 
click the Close button.  Note that there may not be definitions for all words.  
When you see the definition, there is a Copy option.  If you highlight a 
word in the definition box and then click the Copy button, the word you 
highlighted will replace the word in the transcript. 

2. The other options you will see when you right-click on a word is “General 
Lookup”, “Medical Lookup” and “Drug Lookup”.  If you left-click on one of 
the lookup options, the Edit program will attempt to lookup that word on 
the Internet.  Note that you must have an active Internet connection to use 
this option.  We have set up a default Internet site to look for the word, but 
you can set your lookup to go to your favorite Internet site.  To set these 
options, go to Edit Preferences, then click on the Proofread button.  Now 
click the Help button for instructions. 

 
 
May 12, 2010 

• Real-time program – several minor fixes have been made to the real-time 
define (RT-DEFINE).  In addition, the documentation has been updated in 
the User’s Manual concerning making real-time defines. 



• Avsync – the Avsync program has been updated to make it easier to test 
the recording quality.  To start the Avsync, click on the Job Production 
menu in the ACAT Menu program, then click on the Translation menu, 
then click Audio Sync.  Before you can record for the first time, you must 
set the recording quality.  To set the recording quality, start the Avsync 
program, click on the Edit menu, then click Avsync Options. 

• A number of other minor enhancements and fixes to other programs. 
 

 
March 1, 2010 
A new option has been added to the Dictionary Management program.  Do you 
feel like you have two different personal dictionaries?  One on your desktop and 
another on your laptop?  Now you have the ability to merge these two 
dictionaries.  Click on the Personal Dictionary menu, then click Merge Two 
Dictionaries.  Click the Help button for instructions on what to do.  Note that you 
can merge a job dictionary or a personal dictionary from another reporter using 
this option. 
 
 
February 15, 2010 

• A fix has been made to the Print and Multipag programs.  This fix affected 
mostly certain printers such as the HP inkjet printers. 

• The Multipag program has been changed to allow you to print the pages in 
a different order.  Currently the pages are printed 1, 2, 3 down the left side 
of the page, then 4, 5, 6 down the right side (Top to Bottom).  Now you 
can print the pages left to right.  That is, pages 1, 2 on the top row, then 3, 
4 on the middle row and 5, 6 on the bottom row (Left to Right).  By printing 
Left to Right, the reader can see two pages before having to scroll down. 

• Several changes have been made to pick lists. 
1. You can now merge (combine) two pick list files.  So, if you have pick 

list files on two computers that you want to combine or you work with 
someone who has a pick list file you wish to combine, now you can 
easily do it.  To combine two pick list files, open any file in Edit.  Then 
click the View Menu, click the View/Edit Pick Lists menu and choose 
the pick list file you wish to add to.  Now you will see the Edit Pick List 
dialog box.  Now click the Merge button and choose the pick list file 
you wish to merge in (you can navigate to a different drive, such as a 
floppy diskette, to get the pick list file to merge in).  Next you will be 
asked if you want to remove duplicate entries.  If you click Yes, then 
any pick list entry that already exists will not be added.  Note that entry 
has to match exactly (case sensitive) for it not to be added.  Note:  If, 
after adding the second pick list file, you don’t like the results, click the 
Cancel button to abandon the changes. 

2. We have changed the way you edit an entry in a pick list file.  If you 
were making a multi-line entry, such as an attorney name, address, 
etc, you would use the pipe character (|) to separate each line.  Now 



you should press the ENTER key after each line, except the last.  If 
you edit an existing pick list entry that has multiple lines, the Edit 
program will automatically separate each line.  And when you save the 
entry, the Edit program will automatically add the pipe character after 
each line.  Note:  If you are making a single line entry, such as a 
judge’s name, a state or city, etc. do not press the ENTER key after 
the entry. 

3. We have added a command to the Edit program to easily add an 
existing appearance to a pick list file.  To add an existing appearance 
to a pick list file do the following: 
1. Place the cursor at the beginning of the first letter on the first line of 

an appearance. 
2. Press Ctrl+KK (or Ctrl+F5) to mark that first line. 
3. Press the down arrow key to highlight each line of the appearance. 
4. Click on the Tools menu, then click Make Pick List Entry. 
5. The appearance will now appear in the Edit Pick List Entry dialog 

box.  You can now make any changes, such as adding the sort 
field.  Then click the OK button (or press Alt+O). 

6. Now you will be asked which pick list file you want to add this 
appearance to.  Note that you can type in the name of a new pick 
list to add the appearance to. 

 
 
December 21, 2009 

• A Browse button has been added to the File Management program.  The 
Browse button allows you to select different folders on Removable Drives 
to copy, erase, rename, etc. files in that folder.  To access the different 
folders, click on the Browse button, then click on the plus (+) sign to the 
left of the removable drive.  Now look for the folder, left-click once on the 
folder and then click the OK button.  You will now see the files in that 
folder displayed on the bottom window of the File Management Program. 

• A fix has been made to the Edit program.  Some customers have reported 
that sometimes their edit screen would jump or the text would scroll off the 
right-hand side of the screen.  This problem should be fixed.  Note that 
there may be more than one cause for the Edit screen to jump and if you 
still experience this problem, please let us know. 

 
 
December 10, 2009 

• The View Notes program has been changed so that you can elect not to 
show the function key assignments at the bottom of the screen and/or the 
tool bar at the top of the screen.  If you turn off either the tool bar or 
function key assignments, then you will see more of your note file.  To turn 
on or off the tool bar or function key assignment, click on the View menu 
at the top of the screen then click on View Tool Bar or View Function 
Keys.  Note:  If you turn off the view of the Function Keys, you can still 



press a function key to perform that function.  In other words, the function 
keys will still work even if you don’t see what they do at the bottom of the 
screen. 

• The Read program has been changed so that you can now import 
JDefines made on the Stentura, Mira, Fusion and Diamante writers into a 
job dictionary.  At the bottom of the Read screen, you will see a box 
“Import JDefines” that you can check if you want to import any JDefines 
you may have made.  Click on the Help button to get more information 
about importing JDefines.  Refer to your write manual on how to make a 
JDefine on your writer. 

 
 
November 25, 2009 
Changes have been made to the Read and View Notes program that should 
allow synchronizing the sound with the text in Edit and with your notes in the 
View Notes program when reading the notes along with the audio file from the 
Diamante, Fusion and élan Mira writers.  Note:  the sound will only sync correctly 
if you have the Auto Audio Pause feature turned off on your writer. 
 
 
October 20, 2009 

• Permissions have been added to the Print and Multipag programs when 
you make a PDF file.  Permissions for a PDF file allow you to control 
whether or not the recipient can print the PDF file, copy and paste from it, 
etc,  To set these permissions, click on the PDF Options buttons (formerly 
this was the Digital Options button).  Important Note:  By default, all 
permissions are turned off.  This means the recipient can only view the 
file, not print it or copy and paste from it.  If you want to allow the recipient 
to print the file you must explicitly set these options. 

• In the real-time program you now have the option to send time stamps to 
CaseView users.  By default, time stamps are not sent.  To send time 
stamps, click the Real-time Output button on the real-time options screen. 

 
 
July 17, 2009 
The following changes have been made to the real-time program: 

• The Write-to-Window under the Captioning menu in the real-time program 
did not work under Vista.  The Write-to-Window is used to send your real-
time output to any Windows program such as Microsoft Word, Real-time 
Coach, chat applets, etc.  This option now works with Vista. 

• The real-time program now supports the Bridge protocol.  Bridge is a 
viewer program similar to LiveNote that is used by attorneys, judges and 
other viewers to view your real-time output on their computer. 

• The real-time program can now send your real-time output to up to two 
COM ports.  Why this change?  Until recently all viewer software such as 
LiveNote, Summation, CaseView, TotalView, etc. used the CaseView 



protocol.  That means no matter how many attorneys were connected to 
your computer or what viewer software they were using, they all used the 
CaseView protocol, so they were all compatible.  The Bridge software 
uses a different protocol so the possibility exists that some attorneys 
would be using the CaseView protocol and other attorneys would be using 
the Bridge protocol.  So you would have to connect them to two different 
COM ports with two different sets of attorney cables.  StenoCast 
(www.stenocast.com) now has a wireless Bluetooth device that will 
transmit your real-time output to two different COM ports. 

 
To send the AristoCAT real-time software to use the Bridge protocol or to 
setup your real-time to send out to two COM ports, click on the Real-time 
Options button on the Real-time Options screen.  Then click the Help 
button on the Real-time Output screen. 
 
Important Note: This update makes a big change to the real-time output 
to attorneys, judges, etc.  Although we have done extensive testing, if you 
regularly attach to attorneys or to your judge, then you may want to install 
this update only when you have time to test to make sure you don’t 
encounter any unexpected problems. 

 
 
May 27, 2009 
Changes have been made to both the Print and Multipag programs.  When you 
make a PDF file from Print or Multipag and you check the box to include a word 
index, you will now get links to the words in the word index and links to the page 
and line the word appears on.  These links appear in the Bookmark tab.  When 
you open the PDF file, click on the Bookmark tab on the left, if it is not already 
open.  Now click on the plus sign (+) to the left of the Word Index.  You can now 
click on a number or letter and it will take you to that number or letter in the word 
index.   
 
In the example below, we first clicked on the plus sign to the left of Word Index, 
then we click on the plus sign to the left of the $, then we clicked on $1,000.00.  
Now on the right, you will see all of the page and line numbers where $1,000.00 
appears in the transcript.  If you now click on the blue page and line number, the 
transcript will display one the right at that page and line number. 

http://www.stenocast.com/


 
 
Notice that there is also a Page Index which allows you to easily navigate to any 
page and line in the transcript. 
 
 
May 12, 2009 
• A new dot command has been added to the Print and Multipag programs.  

The dot command is .im for image.  This dot command allows you to print 
images (.bmp files) in your transcript and PDF files.  See Appendix C in the 
User’s Manual for detailed information on how to use this dot command. 

• A fix has been made to Review Entries in Batch file in the Dictionary 
Management Program.  When reviewing in batch file and you exit the review 
process, when you go back in to finish the review, the dictionary management 
program will now remember where you left off and return to that point. 

 
Important Notice:  If you are using the height value in the .es dot command, this 
value has been changed to make it consistent with height value in the .im dot 
command.  The height is now expressed in single line spacing.  For example, if 
you use 4 for the height this would be 4 single-spaced lines (2 double-spaced 
lines).  The easiest way to convert from the old value to the new value is to divide 
the old value by 10 (and ignore any remainder.)  For example if the old value is 
40 the new value would be 4.  If the old value was 35 the new value would be 3.  
See Appendix C in the User’s Manual for detailed information on how to use this 
dot command. 
 
 
April 20, 2009 
A fix has been made to the Read program.  If you highlight several files to read in 
as one file, if FILE.002 is highlighted, it will not read in FILE.002.  This has been 
fixed. 
 
 
April 6, 2009 
The following three changes have been made to the Edit program: 

1. You can global print attributes (bold, underline,etc.) in the Edit program.  
When you highlight text and then start typing in the definition, at the top of 



the Definition Dialog box, there is a Format menu.  If you click on the 
Format menu and then click on print attribute you want, the code for that 
print attribute will be add to the English definition.  For example, if you 
want ‘Days of our Lives’ in italics your definition would look like: 

<it>Days of our Lives<it> 
Note that you don’t have to use the Format menu.  You can manually type 
in the code for the print attribute you want.  That is, you can type in <bo> 
for bold, <ul> for underline, etc.  Be sure to type in both the beginning and 
ending print attribute to indicate where you want bold, underline, etc. to 
start and end.  Note that you can both global the print attributes and add 
the definition with print attributes to your personal dictionary.  See the 
March 26 description about print attributes and adding to your personal 
dictionary. 

2. When you press the Home key which stops at a pick list, if you type in an 
entry which is not already in the pick list, you will be asked if you want to 
add it to the pick list.   

3. A rare glitch would sometimes cause the Edit screen to jump up and down 
when editing.  A fix was made to correct that problem.  Please let us know 
if there are any issues with the text displaying on the Edit screen. 

 
March 26, 2009 
• ACAT Menu – In the ACAT Menu program, two new menu items have been 

added under the Web Site menu item.  When you click on these two new 
items, Seminar and Webinar, it will take you to our seminar and webinar web 
page on the AristoCAT web site. 

• A couple of minor glitches have been fixed. 
• We have added the ability to add print attributes (bold, underline, etc.) to 

definitions to your personal or job dictionary.  When you edit a batch file or 
personal dictionary entry, you will see a Format menu item.  If you click on the 
Format menu item you will see a list of attributes to choose from: 

 

 
 
When you click on an attribute, such as bold, the code for bold (<bo>) will be 
inserted in the definition: 

 



 
Be sure to insert both the beginning and ending attribute at the beginning and 
end of the word or phrase you want to bold. 
 
Notes: 

1. You don’t have to use the Format menu to insert the attribute.  You can 
manually type in the attribute you want.  For example, you can type in 
<ul>this will be underlined<ul> 

2. You can define these attributes when making a dictionary entry in Edit.  
However, currently the attributes will not global.  For example, if you have 
a definition like this: 

<it>Italicized Phrase<it>\gd 
This definition will be globaled as ‘Italicized Phrase’ but will not be 
italicized.  It will be put in the personal dictionary batch file with the italics 
attribute and after updating your dictionary, the next time you translate 
‘Italicized Phrase’ will appear in the transcript italicized.  We are working 
on the ability on having the Edit program global these attributes. 

 
 
February 25, 2009 
• A new dot command has been added.  The dot command (.lk) allows you to 

link to external files and/or web sites in a PDF file.  When you (or your client) 
clicks on the link, that external file or web site will be opened up in a browser 
(ie: Internet Explorer).  Examples: 

 
.lk http://www.aristocat.com
.lk exhibit1.bmp 
.lk excerpt.pdf 
 
Note:  You must have a blank line in the transcript immediately following the 
.lk dot command.  The link will appear on this blank line.   

• The dot command (.es) for the electronic signature has been enhanced.  The 
format for the .es dot command is: 
 
.es offset, [width], [height] 

where: 
offset -- is a number indicating how far from the left margin the electronic 
signature should start.  See the December 4, 2008 description below for 
an example. 
width – this is an optional number indicating how wide the signature 
should print.  You would only use the width if you have a file (esign.bmp) 
with your signature.  This value allows you to adjust how wide the 
signature will appear. 
height -- this is an optional number indicating how high the signature 
should print.  You would only use the height if you have a file (esign.bmp) 

http://www.aristocat.com/


with your signature.  This value allows you to adjust how high the 
signature will appear and is expressed in single-spaced lines. 
 
The following example shows an offset of 0 (zero) which means the 
signature will start at the left margin (column 0), a width of 30 which is 
about three inches long and a height of 4 which is 4 single-spaced lines (2 
double-spaced lines) high. 
 
.es 0, 30, 4 
 
You will have to experiment with your own values to see what works best 
with your scanned signature. 
 
Refer to Appendix C – Dot Commands in the User’s Manual for more 
detailed examples.  You can also go to the Resources icon, click on 
Tutorials and then open the Digital Signatures PDF file for additional 
information. 

 
 
February 12, 2009 
• A change was made to the File Management program which will backup 

(copy) all of your files (your entire user folder) to a removable media drive.  To 
backup all of your files, click on the Backup menu item and then click on 
“Backup All Files”.  There is also a Restore All Files option which will copy all 
of your files from a removable media drive. 

• A fix was made to the File Management program.  Under certain 
circumstances, when copying a file from a removable media drive to the hard 
disk, all the files for the job would be copied, not just the file(s) you 
highlighted. 

 
 
 
December 22, 2008 
• A fix was made to the Multipag program.  Under certain circumstances, the 

digital signature was not added to the PDF file.  This has been fixed. 
• An option was added to the real-time and translation program.  If you elect to 

have dollar amounts automatically formatted, you now have the option to add 
.00 to even dollar amounts.  Go to the Automatic Text Formatting options to 
set this option. 

 
 
December 4, 2008 
The following changes have been made to the Print program: 
1. You now have the ability to print a word index like the Multipag word index at 

the same time you print a full size transcript.  This is especially handy when 



making a PDF file as you can now have one PDF file with both the full sized 
transcript and the word index.   
Notes:  
• The page numbers will continue to increment on the word index pages.  

For example, if the last page number of the transcript is 86, the first page 
number of the word index will be 87. 

• The header(s) and footer(s) will continue to print on the word index pages 
just like the transcript pages.  If you wish to remove or change the headers 
and footers on the word index, you can insert dot commands at the very 
end of the transcript to change the headers (.he, .h1, .h2, and .h3) and/or 
footers (.fo, .f1, .f2, .f3, .f4, and .f5).  Examples: 

.h1       (this will remove header 1) 

.f2        (this will remove footer 2) 

.h1 ~Word Index   (this will change header 1 to Word Index and 
center the header) 
.pn off      (this will turn off page numbering on the word index 
pages) 

 
2. You can now add a digital signature to PDF files created by the Print and 

Multipag programs.  Before you can add a digital signature to a PDF file, you 
must first purchase and install a digital signature from a third-party company 
such as Verisign (www.verisign.com).  To add a digital signature to a PDF 
file: 
• Check the Digitally Sign box on the Print or Multipag Options dialog box.  

Make sure you have filled out the fields in Digital Options box.  Click the 
Help button for information about these fields. 

• Add the following dot command in the transcript: 
.es #            where # is a number indicating the page offset (how far 
to the right you want the digital signature to appear). 
The .es (Electronic Signature) dot command should be placed in 
the transcript where you want the digital signature to appear, 
usually on the certificate page.  Example: 

 
.es 35              (this will start the digital signature in column 35) 
 
                                           ___________________________________ 
                                           Lawrence E. Hunt 
    Certified Dog Lover 
 
Note: You will want to experiment with the column number in the .es dot 
command and with blank line(s) before and/or after the .es dot command 
to get the signature exactly where you want it.  
 

Information about getting a digital signature can be found at: 
http://technology.ncraonline.org
 

http://www.verisign.com)/
http://technology.ncraonline.org/


 
November 20, 2008 
We are implementing new PDF creation software.  The PDF creation software 
we were currently using does not produce an accurate representation of the 
printed transcript.  So we have decided to use PDF creation software from a 
different software company.  There are many advantages to this new PDF 
software, one of which is the ability to digitally sign the PDF file (note that this 
capability is not included in this update, but will be available shortly.) 
 
Note:  After you install this master load and click the Finish button, the 
installation will then install a PDF printer driver.  A window will open and you will 
see the process of copying files and at the end of the installation of the PDF 
driver, you should see a message indicating the printer was successfully 
installed.  When you call in for the install code, we will guide you through this 
process. 
 
The following programs have been enhanced in this update: 
 
• Print – there is a box you can check “Export to PDF” and if you check this 

box, a PDF file will be made.  This PDF file should be almost exactly like the 
printed transcript (note that in the previous version of the Print program, this 
box was labeled “Print to PDF”). 

• Multipag – besides the “Export to PDF” box you can check to make a 
Multipag PDF file, there are a couple of other enhancements: 
1. You now have the ability to choose 2, 4, 6 or 8 pages per side (although 8 

pages per side is pretty small.) 
2. You can also print in Landscape mode (sideways).  Landscape mode may 

allow you to print in a bigger font. 
 
Note:  When you make a PDF file in the Edit program using the Export to PDF, it 
will use the old PDF software (that is, it will work exactly like before this update.)  
Using the Export to PDF in the Print program will give you a PDF file which is 
closer to the printed page than using the Export to PDF in Edit. 
 
 


